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 Welcome to issue 120 of Practical Photoshop! 
If you enjoy the issue, why not subscribe and get 
a whole year for just $19.99?  



In need of a diversion? Set your creativity adrift 
with these blissful Photoshop techniques... 
Learn a host of new skills and start making 

amazing images right now

I N  P H O T O S H O P

Lose  yourself

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_120 ON YOUR PC OR MAC 



1  M A G N I F I C E N T 
M A N D A L A  P A I N T I N G

This painting may 
look complicated, 

but we knocked it out 
in about five minutes! 
The secret is Symmetry 
Painting. This wonderful 

feature of the Photoshop 
Brush Tool lets you paint 
in several places at once 
to create patterns and 
symmetrical shapes. Used 
alongside brush features 

like scattering effects and 
smoothing, it doesn’t take 
long to create art like this. 
It’s such a relaxing and 
mindful technique that you 
may lose track of time...

WATCH THE VIDEO
https://bit.ly/3k119pP



01 CREATE THE BASE
Open a blank image or use a photo 

as a base for your painting. We flipped 
and blurred an image here to give us an 
interesting mix of colors and tones for our 
backdrop. Once done, grab the Brush Tool 
from the toolbar and choose a color in the 
Color Picker. Make a new empty layer for 
your painting.

03 PAINT FLOWING SHAPES
Start painting with the Brush Tool, 

and you’ll see paint magically appear in 
several places at once. If you’re using a 
mouse, try increasing Smoothing in the 
options for smooth curved lines. You can 
also experiment with settings in the Brush 
Panel - try increasing Scattering and 
Spacing for a variety of fun effects.

04 USE FILTERS AND BLENDING MODES
To take it further, build up the 

painting effect over several layers, and 
experiment with other Photoshop features. 
Here we’ve added a Radial Blur to our paint 
layer, then blended it with the Color Dodge 
Blending Mode. We’ve then merged and 
duplicated the layer, then rotated it and 
set it to the Screen Blending Mode.

02  SET UP THE BRUSH
Go to the Brush Tool options at the 

top of the screen and click on the butterfly 
icon to enable the Symmetry Painting 
function. Choose your favorite template 
from the list. We used Mandala here. This 
lets you choose a number of segments 
for your symmetrical painting. We opted 
for six segments.



2  I N S TA N T  A R T W O R K 
W I T H  F R E E  T E M P L AT E S

If you go to File > 
New in Photoshop, 

you’ll find an array of fun 
downloadable templates 
to play with. There are 
workmanlike images 
of phone screens and 
laptops that you can drop 
images into, or more 
creative documents like 
the Interlocking Geometric 
Images template we’ve 
used here. With a template 
like this, you need to go to 

the Layers Panel and find 
the layer that says  ‘your 
image here’ or something 
similar. This will usually 
be a Smart Object Layer – 
double click the layer 
image thumbnail to open 
the Smart Object in a new 
window, then copy and 
paste in your own image. 
Finally, save and close the 
Smart Object file to update 
the main image. You can 
replace it later if you like.



3  T H E  A D D I C T I V E  S T E P 
A N D  R E P E AT  T R I C K

With this technique, 
you can create 

flowing shapes and 
unexpected designs in 
seconds. To begin, make 
a new layer, then either 
add a simple shape, paint 
something or make a quick 
cutout, like we did with the 
feather here. Next, press 
Cmd/Ctrl+T to transform 
it. Now make a few tiny 
adjustments – rotate the 

layer very slightly, try 
resizing it a smidge, and 
nudge the position slightly. 
Press Return to apply, then 
press Cmd/Ctrl+Shift+Alt+T 
to ‘step and repeat’. This 
copies the layer and applies 
the same transformation 
again and again. Once 
you’re happy with your 
shape, group the layers and 
copy elsewhere like this to 
build up the effect.



4  N E U R A L  F I LT E R  F U N

Found under Filter 
> Neural Filters, the 

Style Transfer filter uses 
AI to transfer the look of 
a painting or artwork to 
your photo. You never 
know quite how your 
image will look – it might 
be brilliant, or it might not 
work well at all – but it’s 
fun to experiment with the 
different painting presets. 
The filter usually works 
best on images with strong 
bold simple shapes, like the 
staircase here.



5  M A K E  M U LT I P L E 
E X P O S U R E S

The Screen 
and Multiple 

Blending Modes 
are two of the 
most useful tools 
for creating simple 
yet eye-catching 
multiple exposure 
effects. Simply 
drag and drop one 
image on top of 
another, then go to 
the Layers Panel 
and change the 
Blending Mode to 
either Screen or 
Multiply. To take it 
further, you could 
try inverting layers 
(as we did here to 
turn dark branches 
into white streaks).



6  T R A N S P O R T  Y O U R S E L F 
T O  A  M U S I C  F E S T I VA L

With many of 
us yearning for 

shared experiences at 
the moment, this could 
be a cathartic way to get 
with the crowd. It’s also 
a simple introduction to 
compositing, and it takes 
mere minutes…

WATCH THE VIDEO
https://bit.ly/3qzHvDP



01 REMOVE THE 
BACKGROUND

Open the crowd 
image (we used a 
free image from 
pixabay.com- search 
for 2564431) and 
your portrait. Go to 
the Layers Panel 
and click the lock 
on the layer to 
unlock it, then go 
to the Properties 
Panel (Window > 
Properties) and 
click the Remove 
Background quick-
action button.

03 ADD A FLARE 
We’ve used a free flare image 

(pixabay.com image 949934) to enhance 
the atmosphere. Copy it in, position 
and set the Blending Mode to Screen. 
Finally, merge all of the layers with Cmd/
Ctrl+Shift+Alt+E then go to Filter > Camera 
Raw Filter. Choose a Profile in the Basic 
Panel to skew the colors and tones.

02  BLEND AND BLUR
Grab the Move Tool and drag the 

cut-out portrait into the crowd image. 
Press Cmd/Ctrl+T to transform and resize 
the layer to fit. We’ve blurred the crowd 
slightly to make our main subject stand 
out. Highlight the layer and go to Filter 
> Blur Gallery. Use Field Blur and control 
the blur strength with the circular icon.



7  P AT T E R N S  O N  T H E  F LY

This fun feature 
lets you see a live 

preview of patterns as you 
create them. Simply go to 
View > Pattern Preview. 
You’ll see a blue box appear 
around your document - 
this is your pattern-making 
area (although you can 
work outside of it). Beyond 
the rectangle, anything you 
add to it will be repeated ad 
infinitum. Simply zoom out 
to see your pattern preview 
duplicated endlessly. Once 
you’re happy, go to Edit > 
Define Pattern to save the 
pattern for future use.

WATCH THE VIDEO
https://bit.ly/3boaHXZ



Transform treasured memories 
into memorable wall art.
Mounted under acrylic, framed, or as large-format photo prints. Made in Germany by people 
who love photography. We are the proud recipients of over 100 awards and recommendations! 
Simply upload your photo and create custom works of art – even from your smartphone.

WhiteWall.co.uk
Stores in London | Berlin | New York | Paris | Vienna | Zurich
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There are lots of 
tools that can help 

your images pop out of 
the screen or from a print, 
but few have as instant an 
effect as Clarity. Available in 
Camera Raw and Lightroom, 
Clarity works by increasing 
the contrast in midtones, 
the range of tones that sit 
either side of the middle 
grey point in an image. By 
increasing midtone contrast, 

Master one of the best detail-enhancing 
tools on offer in Photoshop and Lightroom

BRING SOME CLARITY 
TO YOUR PHOTOS

 DOWNLOAD THE PROJECT FILES HERE https://bit.ly/pho_120 ON YOUR PC OR MAC 

WATCH THE VIDEO
https://bit.ly/2Zv3D6h

AFTER

wet strand stand out more 
clearly. It also has a big 
impact on the crispness of 
the droplets around the dog.

Simple and effective, 
Clarity is one of the best 
tools Adobe offers for 
enhancing images. Its only 
drawback is the danger that 
you might apply it too much, 
as a heavy-handed approach 
can leave images looking 
over-processed.

the brighter parts of the 
midtone range become 
brighter, and the darker 
parts go even darker.

All you need do is open 
an image and experiment 
with Clarity to get a feel 
for the amazing effect it 
has on details. In the photo 
above, for instance, a bold 
increase in Clarity boosts 
the contrast around the 
dog’s hairs, making each 

BEFORE



1

CLARITY IN EYES
Clarity can work wonders 

over eyes – both human and 
animal. In particular, the 

iris will benefit, especially 
if you apply Clarity along 
with a slight increase in 

Exposure and Saturation. 
Use the Adjustment Brush 

and paint precisely over the 
iris, then increase Clarity to 
boost the detail in the iris. If 
you like, make further local 
adjustments to boost the 
whites of the eye and to 

darken the edges of the iris.

2

MIDTONES
A photo’s tonal range is 

broadly split into shadows, 
midtones and highlights. 
In a histogram, midtones 

occupy the central third of 
the graph, with the shadows 

on the left and highlights 
on the right. Clarity affects 
the midtones by increasing 

contrast in this central 
area. You might see the 
peaks near the center 

spread slightly apart as the 
midtones shift towards 
highlights and shadows.

3

1

2

3

ON-IMAGE CONTROLS
When the target is toggled 
on, you can drag over the 
image itself to adjust the 

color ranges within it. Here, 
for example, we can drag 

over the backdrop and 
transform the blue colors 
to another hue. Using the 
in-image adjustment tool 
is usually more effective 

than manually tweaking the 
sliders on the right. Not only 

is it quicker, it also lets you 
affect more than one color 

range at a time.



4

NEGATIVE CLARITY
Most of the time you will 

want to add Clarity to crisp 
up the details in an image. 
But you can use negative 

Clarity, too. This has a subtle 
softening effect, which 

can be useful when applied 
selectively. It can allow you 

to de-emphasize distracting 
details, tone down overly 

contrasted areas, or reduce 
a strong global Clarity 

setting in areas where its 
effects are too strong. The 
softening effect can look 

great over skin, too.

5

CLARITY AND NOISE
Clarity can be great for 

textures and detail, but it 
can have an adverse effect 
on parts of an image, too. 
It tends to push tones into 

shadow, so you might need 
to counter this by increasing 

the Shadows slider. It can 
also result in haloes around 

high-contrast edges like 
horizons, and a heavy 

approach can introduce 
noise. To counter increased 

image noise, head to the 
Detail Panel and set Noise 
Luminance to around 30.

5

CLARITY SLIDER
To get started using Clarity, 

simply open an image in 
Lightroom or Camera Raw 
(in Photoshop, go to Filter 
> Camera Raw Filter), then 

head to the Basic Panel. 
Drag the Clarity slider to 
the right and notice how 

it crisps up the details and 
enhances the textures in 
the image. All images are 
different, but typically it’s 

best not to go too high with 
the amount; around 40 or 
less will be sufficient for 

most photographs.

4

5

6



BEFORE

One of the best things 
about digital imaging 

is the ability it gives you to 
visualize places and scenes 
that could otherwise only 
exist in dreams. With a few 
simple Photoshop skills, 
anybody can craft a fantasy 
scene that wouldn’t look out 
of place on a movie screen.

You might have a 
selection of photos in your 
own library that would 
be ideal for a fantastical 
composite like this, but if 

James Paterson crafts an epic fantasy composite image with 
a range of images using Photoshop’s clever montage tools

BUILD A FANTASY WORLD

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_120 ON YOUR PC OR MAC 

you want to look further 
afield you’ll find tons of 
resources online. We’ve used 
several free images from 
www.pixabay.com, which is 
a useful resource of rights-
free photos. The great 
thing about a project like 
this is, even though these 
photographs have probably 
been displayed thousands 
of times in various different 
ways, we can still use them 
to create something that’s 
completely unique.

One of the keys to 
compositing is mastering 
selections and masks. These 
allow us to cut out bits and 
pieces then bring them 
together, as if we were 
making a collage with paper 
and scissors. As well as 
these powerful tools, we’ll 
also explore how to color-
match our photos, which 
is a vital skill when you’re 
bringing together a range 
of photos from different 
sources like this.

WATCH THE VIDEO
https://bit.ly/3qN8R9H



01 COPY IN THE 
MOUNTAINS

Open your shots. We got 
four from www.pixabay.
com – search for 1185474, 
2051448, 3021664, 
690104. Go to the 
mountains image, then grab 
the Quick Selection Brush. 
Paint over the mountains, 
and use the Move Tool to 
drag them across to the 
foreground as shown.

02 MASK THE EDGES
Position the mountain 

range with the Move Tool 
and transform with Cmd/
Ctrl+T to resize it, if needed. 
Once that’s done, click the 
Add Layer Mask icon in the 
Layers Panel. Grab the Brush 
Tool and paint with black 
to hide parts of the mountain 
range layer, blending it in 
with the foreground area 
in the other layer.

03 MATCH THE COLORS
Highlight the bottom 

layer, then add a Curves 
Adjustment Layer. Click on 
the midpoint eyedropper 
and click on the snow. Next, 
highlight the top layer. Add 
another Curves layer and 
click the Clip To Layer icon. 
Sample the color on the 
snow, then drag the top 
of the diagonal line down, 
like so.



04 PLACE THE STATUE
To start adding the 

statue image, go to Select > 
Subject. Click the Add Mask 
icon, then use the Move 
Tool to drag the statue into 
the main image. Press Cmd/
Ctrl+T to enter Transform 
mode, then hold down the 
Cmd/Ctrl key and drag the 
corners to skew the statue 
so that it matches the 
scene’s perspective.

05 BLEND THE LAYERS
Highlight the mask 

on the statue layer and 
paint with black to blend the 
statue with the mountain. 
Add a Curves layer and again 
clip it to the layer below, 
then sample the snow on 
the statue to match up 
the colors. If you like, you 
can reshape the mountain 
to match the statue with 
Liquify (Filter > Liquify).

06 DROP IN THE STARS
Merge a layer with 

Cmd/Ctrl+Shift+Alt+E, then 
go to Select > Sky. Hold 
down the Alt key and click 
the Add Mask icon. Drag in 
the stars image, then drag 
it below the merged layer 
in the stack. As before, use 
a Curves layer to tweak the 
toning. Make any other tonal 
changes you like to finish off 
the composite.  



The colored shadow 
look is an old-school 

technique you’re just as 
likely to see in a science 
museum as in a photo, but 
is becoming increasingly 
popular as photographers 
explore optical in-camera 
effects. As well as being 
a vibrant way to shoot a 
portrait, it’s a fascinating 
demo of color theory.

To split our shadows 
into different colors, we 
need three separate light 
sources, colored red, green 

James Paterson splits shadows into bold hues with a clever 
lighting trick, and teaches the fundamentals of color theory

COLOR-CAST SHADOWS

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_120 ON YOUR PC OR MAC 

and blue. When working in 
combination – as we see in 
the light hitting the subject 
here – the three colors form 
normal white light. This 
is down to the concept of 
additive color mixing, where 
red, green and blue light 
combine to form white. But 
when our three lights are 
spaced apart, something 
very interesting happens.

Each light creates its 
own shadow, just as any 
normal light would. But the 
shadows take on different 

WATCH THE VIDEO
https://bit.ly/2Zv1sQ7

colors – and they’re not 
necessarily the colors we 
started with.

Each shadow blocks 
one of the three colors, so 
what’s left is a mixture of 
the other two shades. The 
results are secondary colors 
– the red and blue combine 
to create magenta, red and 
green make yellow, and 
blue and green make cyan. 
If your subject is close to 
the backdrop, you may see 
touches of red, green and 
blue as well.



https://avxlive.icu/


https://avxlive.icu/


SHADOW PLAY

1 WHITE BACKGROUND
A white background is best 

for this effect, as it will show 
the colors of the various 

shadows clearly. We used 
a roll of white vinyl here. If 
you don’t have a dedicated 
backdrop to hand, like this, 

you could always use a 
plain white wall instead, 
or pin up a white sheet. 

4 COLORED SHADOWS
By fixing red, green and blue 

gels to our three lights our 
shadows are tinted. Each 

shadow blocks one or two 
of the three color gels, so it’s 

a mixture of the remaining 
color. Red and green create 
yellow; red and blue create 

magenta; and green and 
blue create cyan.

2 STUDIO FLASHES
We need three lights 

working in combination to 
create our colored shadows. 

We’ve used three studio 
heads on light stands here. 

If you don’t have studio 
lighting, you could equally 

use three flashguns or 
continuous lights; any 
type of lighting will do.

5 EXTRA FLASH
If you find the lighting on 
your subject’s face needs 

a lift, try an extra flash. 
In this case, we’ve used a 

softbox. The light is angled 
back towards the face from 

behind so that it doesn’t 
fall upon the backdrop – 

if it did, it would dilute the 
shadows in the shot. 

3 FLASH TRIGGER
You’ll need to be able to fire 
your flashes off-camera, so 
either attach a sync cable, 
use a wireless trigger and 

receiver, or use an on-
camera flash. Here we’ve 
used a hotshoe-mounted 

flashgun to trigger the 
studio flashes, which are 

each set to Optical Remote.

6 POSITION AND HEIGHT
The position of the lights 

determines where the 
shadows fall, so experiment 

with the angles until the 
shadows look right for 

what you want. The height 
of the lights also impacts 
the shape. By setting the 
lights diagonally here, the 
shadows become angled. 

Get set up to create boldly colored shadows

2

5

4

6

1
3



TOP TIPS FOR TINTED SHADOWS

01 ATTACH THE GELS
You can find decent 

inexpensive gels online to 
attach to your three lights. 
If you’re using studio flash, 
keep the modeling lights off 
if you can, as the heat can 
melt the gels. The order of 
the red, green and blue lights 
will have an impact on the 
order of the shadows, so 
experiment with different 
light sequences.

02 BALANCE THE LIGHTS
Turn the lights on one 

at a time and play with the 
output, taking test shots 
until each records a deep 
color, like the red above. 
Then turn all the lights on; 
combined, they will create 
white light but may have 
a red, green or blue cast. If 
so, lower the output of the 
relevant light until the light 
looks balanced.

03  CREATE HARD 
SHADOWS

Our shadows need to be 
hard-edged to make each 
color stand out. Small light 
sources create hard-edged 
shadows, so the smaller 
the flash bulb, the better. It 
also helps if you put some 
distance between the flash 
and subject, as this makes 
the light source smaller in 
relation to the subject.



04 SET THE EXPOSURE
Just as with normal 

studio lighting, we need to 
set our camera to Manual 
mode, with ISO 100 and a 
shutter speed of 1/200 sec 
(or the max flash sync speed 
on your camera – check your 
camera manual). Start with 
a mid-range aperture like f/8, 
then adjust, if necessary, if 
you want the image to be 
brighter or darker.

05 EXPERIMENT 
WITH LIGHT

In step 3, we positioned our 
three lights to the left of the 
camera so that the shadows 
fell to the right side. But you 
can try all kinds of angles 
for your lights. Here the red 
and blue lights are placed 
on different sides of the 
subject, resulting in shadows 
that surround the figure and 
create a different feel.

06 CHECK YOUR 
DISTANCES

The distance between the 
subject and the backdrop 
also has an effect on the 
spread of shadows. If 
they’re stood close to the 
backdrop, then shadows 
will be more clustered 
together, and you might 
only see red, green and blue 
areas where two of the 
three lights are blocked.

TOP TIPS FOR TINTED SHADOWS



ENHANCE YOUR COLORS

01 FIX COLOR CASTS
It can be tricky to 

balance out the red, green 
and blue flashes to combine 
to white, so you may find 
during editing that your 
images display a color cast. 
You can remove color casts 
with the White Balance 
Tool in Camera Raw or 
Lightroom. Click on a point 
that you want to be neutral, 
like our backdrop here. 

02 ENHANCE COLORS
Some of the colors 

may look weaker than 
others. Go to the Color 
Mixer Panel in Camera Raw 
or Lightroom and click the 
Saturation tab, then grab 
the Target Tool. Next, 
click and drag to the right 
over colors in the image to 
target and enhance color 
ranges. Experiment with 
the Luminance of colors too.

03  SEPARATE 
THE SUBJECT 

If you find it hard to balance 
out the subject with the 
backdrop, you can edit each 
separately. Open the shot in 
Photoshop, then go to Select 
> Subject. Duplicate to a 
new layer with Cmd/Ctrl+J, 
then use Color Balance (Cmd/
Ctrl+B) to edit the subject, or 
switch to the bottom layer to 
edit the backdrop.



If you’d like to watch the  
complete course now, get the 
app from the Apple App Store

This issue, contol detail in 
the highlights and shadows 
in high-contrast scenes

LEARN LIGHTROOM TODAY!

LIKE THIS? NOW AVAILABLE ON 
THE APPLE APP STORE BIT.LY/TYLRAPP

BUY
NOW!

WATCH THE VIDEO
https://bit.ly/3pzLv5Q



Your quick-start guide and reference  
to image editing in Photoshop

If you’re relatively new to editing in 
Photoshop, or you just don’t know 

where to begin, then this section is the best 
place to get started. Over the next 10 pages, 
you’ll find an overview of the different versions 
of Photoshop available; a breakdown of the 

typical image-editing workflow in Photoshop; 
an overview of raw file editing; a guide to the 
six most useful layers; and a glossary of the 
most useful shortcuts. This guide condenses 
most of the tools and techniques you’ll use 
every time you import a new roll of pictures.



CREATIVE CLOUD PLANS 
CHOOSE THE PLAN WITH THE COMBINATION OF TOOLS AND STORAGE YOU NEED

Photography Plan • 20GB Photography Plan • 1TB

Best for Traditional desktop users Cloud and desktop

Price per month £9.98/$9.99 £19.97/$19.99

Photoshop CC

Lightroom CC

Lightroom Classic

Lightroom Mobile

Cloud storage 20GB 1TB

Notes

If you want Photoshop, 
you need the regular 

Photography Plan – you 
also get Lightroom Classic

The same as the Photography 
Plan, but with 1TB storage. 
Existing users are offered 

a discount for the first year

Lightroom Plan All Apps Plan

Best for Cloud fans Mobile-only users

Price per month £9.98/$9.99 £49.94/$52.99

Photoshop CC

Lightroom CC

Lightroom Classic

Lightroom Mobile

Cloud storage 1TB 100GB

Notes
With this plan you get the ‘new’ 
Lightroom CC and 1TB storage – 

but not Photoshop

Includes all Adobe apps, 
including Illustrator, Premiere 

and After Effects



Lightroom CC combines 
professional image-
processing tools with 

asset organizing. It keeps all its 
images online in the Creative 
Cloud, with advanced image 
search capabilities.

Lightroom Classic 
offers editing and 
organizing tools, but 

you can only store images on 
your computer.

LIGHTROOM CC
FROM £9.98/$9.99 PER MONTH  
WINDOWS, macOS

LIGHTROOM CLASSIC
FROM £9.98/$9.99 PER MONTH  
WINDOWS, macOS

Lightroom Mobile is 
the lightweight iPad, 
iPhone and Android 

version of the application, 
integrated with Lightroom 
CC. You can use Lightroom 
Mobile on its own for free, 
or use the Premium In-App 
Purchase to access the Adobe 
Creative Cloud. This enables 
you to create a collection 
of photos on your desktop 
copy of Lightroom, and sync 
them via the Creative Cloud 
to Lightroom Mobile on your 
portable devices. You can also 
get Lightroom Mobile via any 
Photography Plan.

LIGHTROOM MOBILE
FREE (PREMIUM: £4.49/$6.49 PER MONTH)
IPHONE, IPAD, ANDROID 

Photoshop is the software of choice for most professional 
and non-professional photographers. Beyond the standard 
photo-editing features, it boasts a vast array of more 

creative tools and filters. Layers are one of the key differences 
between Photoshop and Lightroom. They enable you to mask 
out selected parts to build up increasingly sophisticated images.

PHOTOSHOP CC 
FROM £9.98/$9.99 PER MONTH WINDOWS, macOS 

Elements is the consumer variant of Photoshop, and 
contains many of its key tools and features within a 
simplified interface. It’s limited, but it does provide access 

to layers for those who have switched to a Lightroom workflow.

ELEMENTS 15 £79.99/$99.99  WINDOWS, macOS



Adobe Shape enables 
you to turn photos and 
sketches into beautiful 

vector shapes for use in your 
designs or artwork. The app 
smooths out jagged edges in 
images, resulting in gorgeous 
vectors that are endlessly 
scalable, just as if you’d drawn 
them by hand with the Pen tool. 
Make a shape with the mobile 
app and the next time you open 
Photoshop on your desktop, the 
shape will sync to your Library. 
Drag it in to any document to 
add color and make further 
adjustments.

ADOBE SHAPE
FREE
IPHONE, IPAD, ANDROID 

Adobe Brush enables 
you to make your 
own custom brushes 

from photos or sketches for 
use in Photoshop, Illustrator 
or the Sketch app. The most 
successful subjects are usually 
those that can be easily 
isolated, such as a splash 
against white, or a leaf against 
the sky. You can capture objects 
for your brush tips using your 
device’s camera, choose from 
your camera roll, or use your 
Creative Cloud library. Once 
captured, you can then fine-
tune the look of the tip and 
apply brush settings.

ADOBE BRUSH
FREE
 IPHONE, IPAD, ANDROID 

Mix enables you to merge two photos together 
to create a composite image. It offers a simplified 
compositing process that makes it easy for beginners 

to start combining an object from one image with a background 
from another. You can then send the composite to Photoshop 
for further edits. If you like, you can also use Mix to edit a single 
image. It offers a few simple tonal adjustments and more 
complex edits such as Content-Aware Fill.

If you ever need help 
selecting coordinated colors 
for your designs, try using 

Adobe Color. It enables you to create 
color themes from photos taken on 
your mobile device. This could be 
anything from a scene in your local 
park to a famous painting. So if you 
come across an inspirational scene, 
capture the colors and save them.

ADOBE PHOTOSHOP MIX
FREE IPAD, ANDROID

ADOBE COLOR
FREE IPHONE, IPAD, ANDROID 



As the name suggests, this app enables you to paint 
freehand using a selection of brushes, colors and other 
tools. However, Sketch is more than just a painting 

app. It also enables you to connect with like-minded creatives, 
so you can follow artists and see their work updating. Once 
you’re done sketching the image on your iPad, you can upload 
to the Sketch community, or continue working on the image 
in Photoshop CC. You can also bring in brushes made with 
Adobe Brush, and for those who can’t paint, there’s an option 
to overlay images so you can trace over a photo. Sketch is 
compatible with Adobe’s pen and ruler hardware, Ink and 
Slide, but you can get great results with your finger.

Fix is a retouching app 
for altering portraits and 
fixing marks or blemishes 

in your photos. Intelligent facial 
recognition locks onto eyes, lips 
noses and chins, making it easy to 
tweak a smile, tuck in a jawline or 
enlarge eyes, should you wish.

ADOBE PHOTOSHOP SKETCH
FREE IPAD

PHOTOSHOP FIX
FREE  IPAD 

If you’re a designer 
who wants to build 
a quick layout for a 

web or print page, then Comp is 
the ideal place to start piecing 
ideas, images and text together. 
You can draw common design 
elements such as text or image 
boxes with quick gestures. For 
example, a couple of squiggly 
lines with a dot makes a 
header, and a cross makes an 
image box. It makes it easy to 
mock up a layout in seconds. 
You can then add words and 
graphics. The app even spits 
out a Photoshop, Illustrator or 
InDesign document.

ADOBE COMP CC
FREE IPAD

Behance is the online 
social space for 
creatives to share 

and showcase their portfolios, 
connect with one another, 
and find work. With work 
from the best photographers, 
digital artists and designers 
out there, it’s also a great 
place to find inspiration for 
a new project. If you’re a 
Creative Cloud subscriber you 
can set up a Behance page in 
minutes. The Behance app 
for iOS devices enables you to 
manage your page, while the 
Creative Portfolio app provides 
a polished portfolio.

BEHANCE 
CREATIVE PORTFOLIO
FREE IPAD, IPHONE
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The image-editing process begins as 
soon as you’ve transferred your photos 

from your memory card to your computer.
The first stage is to begin sifting 

through your pictures to discover which are 
the keepers. The image organizer that comes 
with Photoshop is ideal for this task. Adobe 
Bridge has controls for keywording, rating and 
filtering your images, and there are handy tools 
for batch renaming files, creating panoramic 
stitches, making contact sheets and more.
        Launch Adobe Bridge and navigate to a 
folder containing new images. Use the cursor 
keys to quickly flick through the images and 
click below a thumbnail to add a star rating, or 
use the keyboard shortcut Cmd/Ctrl+1-5. You 
can then filter your photos by the star rating to 
group the ones you want to work on.

   The next step is to open the shots from 
Bridge into Adobe Camera Raw. ACR is the best 
place to make initial changes to your images 
to boost tones and correct any problems with 
exposure and so on. It doesn’t enable you 
to combine images – you’ll use Photoshop 
for that – but it does enable you to make 
the kind of edits photographers need.
      In Photoshop, you can further refine the 
image with layers and adjustment layers, which 
offer a much more flexible way of working than 
ACR. Once you’ve finished, it’s time to share 
it with an audience. Go to File>Save, and your 
image will be saved as a Photoshop document 
(PSD). This keeps all the layers intact, which 
means you can go back and retweak the image 
at a later date. However, PSD files are large 
and can take up lots of hard drive space. If you 
want to share your images online or via email or 
social media, save them as JPEGs.

Manage your photos from capture to output in three stages

2

1

3



Discover how to process your raw files to perfection

The latest version of the raw file 
processor included with Photoshop is so 

powerful that most photos can be processed 
entirely in the raw processor, with no need for 
further editing in Photoshop. And by making 
your adjustments in Adobe Camera Raw, 

rather than in Photoshop, you’ll ensure the 
best possible image quality, because raw files 
contain more picture information than bitmap 
images such as un-layered PSDs and JPEGs. 
Here’s our reference to the features you’ll 
use the most in the Basic panel.

THE BASIC 
PANEL IN ACR

TEMPERATURE
Use this slider to warm 
or cool an image if the 
White Balance tool fails 
to correct a color cast

CONTRAST 
Makes light pixels brighter 
and dark pixels darker

CLARITY
Controls the amount 
of midtone contrast

SATURATION
Controls the overall color 
intensity of the image

TINT 
This slider enables you to 
correct a green or magenta 
cast, again, if the White 
Balance tool fails

HIGHLIGHTS 
Controls the brightness 
of the lightest pixels

EXPOSURE 
Controls the overall 
brightness of the image

BLACKS 
Sets a point on the tonal 
range at which pixels 
should be pure black

SHADOWS
Controls the brightness 
of the darkest pixels

WHITES 
Sets a point on the tonal 
range at which pixels 
should be pure white

VIBRANCE
Adjusts the intensity of 
the less-saturated colors



The six most frequently used Photoshop layers for image 
editing, and how to use them to improve almost any photo

Photoshop has many types of layers 
and adjustment layers available, but 

there are six that you’ll find you need to use 
again and again. Learning how they should be 

used may seem a little daunting for beginners, 
but once you’ve got to grips with them, you’ll 
find they play a part in the creative process of 
almost every image you make.

02 CURVES
Curves is one of the most powerful 

adjustment layers. An S-shaped curve 
brightens the highlights and darkens the 
shadows, resulting in extra contrast. Create 
a Curves Adjustment Layer and click the 
middle of the diagonal line to add a central 
control point. Drag down on the lower part 
of the line and drag up on the upper part of 
the line to improve image contrast.

01 LEVELS
This should be the first layer you add 

to an image, because it fundamentally alters 
the tonal range of the entire image. Create 
a Levels Adjustment Layer, drag the Black 
point slider inwards until it touches the left-
hand edge of the histogram, and drag the 
White point slider inwards to the right-hand 
edge. This remaps the tones of the image to 
make more of the available tonal range.

03 HUE/SATURATION
This adjustment layer is best used 

for altering the intensity and brightness 
of individual color channels in an image – 
greens and blues in landscapes, for instance. 
Create a Hue/Saturation Adjustment Layer, 
click the Master menu and choose the color 
channel you’d like to adjust. Small changes 
are usually the most effective.



BEFOREAFTER

06 SELECTIVE SHARPENING
Once all other adjustments have 

been made, you need to sharpen the image 
for output. The traditional way is to create a 
merged layer at the top of the stack, apply 
Unsharp Mask, then paint on the mask to 
remove the sharpening from those parts 
of the image you want to remain soft. 
However, the Sharpen tool enables more 
control over the process by enabling you to 
build up the effect by brushing repeatedly 
with a low opacity brush. Create a new blank 
layer, select the Sharpen tool, tick Sample All 
Layers and set a Strength of 50% or lower.

05 DODGE AND BURN
One of the best ways to enhance a 

photo is by lightening or darkening selected 
areas of the image. This can be done with 
the Dodge and Burn tools, but rather than 
use them directly on the image, a separate 
grey layer gives you greater control. To 
create a Dodge and Burn layer, hold down 
Alt and click the Create a new layer icon in 
the Layers panel. Give the layer a name, 
then choose Mode: Overlay. Check Fill with 
Overlay-neutral color and click OK. Now use 
the Dodge and Burn tools (with Range set to 
Midtones) to work on the new layer.

04 HEALING LAYER
Most photos contain unwanted 

marks or blemishes. The Spot Healing Brush 
tool is effective at removing these. The best 
way to apply the healing is on a new blank 
layer, so that you can easily tone down or 
remove selected healing work later without 
having to start from scratch because you 
healed directly on the background layer. 
To do this, create a new blank layer, choose 
the Spot Healing Brush tool from the Tools 
panel and tick Sample All Layers on the 
Options bar, then continue as normal.



D
Reset the foreground and background colors 
to black and white

ALT+[SCROLL WHEEL]
Zoom in or out of the image

[ OR ]
Resize the brush tip

CMD/CTRL+SHIFT+ALT+E
Create a merged copy of all the layers in the 
layer stack

SHIFT+[ OR ]
Cycle backwards or forwards through the 
layer blend modes

SPACE BAR
Temporarily switch the current tool to the Hand 
tool, for moving around the image while zoomed in

CMD/CTRL+[LAYER MASK]
Load the currently active layer mask as 
a new selection

ALT+[EYE ICON]
Switch off the visibility of all other layers in the 
layer stack, for before-and-after comparisons

CMD/CTRL+T
Activate the Free Transform tool

CMD/CTRL+I
Invert the color of a layer mask to black

SHIFT+[LAYER MASK]
Disable the effects of a layer mask

CMD/CTRL+J
Duplicate the current layer

X
Switch the foreground and background 
color swatches

14 keyboard shortcuts that will massively improve your 
speed and efficiency while working in Photoshop

CMD/CTRL+Z
Undo the last change made to the document. 
Works multiple times
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